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Chapter 

1 
Introduction 
 
Climate change scenarios developed from Global Climate Models (GCMs) are the initial 

source of information for estimating plausible future climate. However, the spatial resolution 

of GCMs is too coarse to resolve regional scale effects and for the output to be used directly 

in local impact studies. Downscaling techniques potentially offer a way of improving regional 

or local estimates of variables from GCM outputs.  

Downscaling methods, as reviewed in Wilby and Wigley (1997) and more recently in Wilby et 

al. (2004) and in Mearns et al. (2003), are divided into four general categories: regression 

methods (e.g. Hewitson and Crane, 1996; Wilby et al., 1999), weather pattern approaches (e.g. 

Yarnal, 2001), stochastic weather generators (e.g. Richardson, 1981; Racsko et al, 1991; 

Semenov and Barrow, 1997; Bates et al, 1998) and limited-area climate models (e.g. Mearns et 

al., 1995). Among these approaches, regression methods are regularly used because of their 

ease of implementation and their low computational requirements. Statistical downscaling is 

based on the fundamental assumption that regional climate is conditioned by local 

physiographic characteristics as well as the large scale atmospheric state. Based on this 

assumption, statistical relationships between local observed meteorological variables (the 

“predictands”) and observed large scale climate fields (the “predictors”) may be developed. 

GCM simulations can then provide information about future large scale atmospheric 

conditions and, in conjunction with these statistical models, be used to downscale to the local 

level. The major weaknesses of statistical downscaling methods are that the fundamental 

assumptions on which they are based are not verifiable, i.e. that the statistical relationships 

developed for the present day climate also hold under different forcing conditions of 

plausible future climate (e.g. Wilby et al., 2004), and that they cannot explicitly describe the 

physical processes that affect climate. In spite of these limitations, these methods may be 

helpful for impact studies in heterogeneous environments and/or for generating large 

ensembles or transient scenarios. 
3 
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Automated statistical downscaling model  
 
An automated regression-based statistical downscaling model (ASD, see Hessami et al., 2008), 

inspired by the existing Statistical Downscaling Model (SDSM; developed by Wilby et al., 

2002) was developed within the Matlab environment (The Mathworks, 2002). Figure 1 shows 

the general scheme of the ASD framework for generating climate scenario information. 

 

NCEP 
predictors 

Select best predictors using 
stepwise regression / partial correlation 

Generate simulations 
 using NCEP data  

GCM 
predictors 

Set 
VIF and bias  

Set 
model configuration Predictand 

Calibrate model 

Generate scenarios
 using GCM data  

Results evaluation  

Figure 1: ASD architecture 

The model process can be conditional on the occurrence of an event (i.e. for precipitation) or 

unconditional (i.e. for temperature). Hence, the modelling of daily precipitation involves the 

following two steps: modeling precipitation occurrence followed by the modeling of 

precipitation amounts (if precipitation occurs), as described in Wilby et al. (1999) and 

Hessami et al. (2008):  
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where  is the daily precipitation occurrence,  are daily precipitation amounts,  are 

predictors, n is number of predictors, 

iO iR ijp

α and β  are model parameters and  is modeling 

error. The modeling of daily temperature is performed in one step: 

ie

∑
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where  is the daily temperature (maximum, minimum or mean) and iT γ  is the model 

parameter. Once the deterministic component is obtained, the residual term  is modeled 

under the assumption that it follows a Gaussian distribution: 

ie

bSze ei
VIF

i += 12     (3) 

where zi is a normally distributed random number, Se is the standard error of estimate, b is the 

model bias and VIF is the variance inflation factor. When calibrating the model, NCEP 

reanalysis data (e.g. National Centre for Environmental Prediction, Kalnay et al., 1996) must 

be used to represent observed large-scale atmospheric conditions, and the VIF and b values 

are set to 12 and zero, respectively, for generating scenarios to assess the performance of the 

model. When using GCM data for scenario generation, the VIF and the bias can be set 

automatically using the following equations: 

dobs MMb −=      (4) 

2
)(12

e

dobs

S
VVVIF −

=  (5) 

where Vobs is the variance of the observations during the calibration period, Vd is the variance 

of the deterministic part of model output during the calibration period, Se is the standard 

error, Mobs and Md are the mean of the observations and the mean of deterministic part of the 

model output during the calibration period, respectively. 

 
Regression methods   
 
Regression-based downscaling methods often use multiple linear regression, however the 

nonorthogonality of the predictor vectors can make the least squares estimates of the 

regression coefficients unstable. In addition to multiple linear regression, the ASD tool 
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provides the option of using ridge regression (Hoerl and Kennard, 1970) to alleviate the 

effect of the nonorthogonality of the predictor vectors. The ridge regression coefficient b for 

the linear model y=Xb+e can be calculated from 

yXkIXXb tt 1)( −+=  (6) 

where I is an identity matrix and k is the ridge parameter. When k=0, b is the least squares 

estimator. The predictor variables should be first standardized to have zero mean and unit 

variance.   

 
Predictor selection methods  
 
In SDSM (Wilby et al., 2002), selection of predictors is an iterative process, partly based on 

the user’s subjective judgment. In the ASD tool, we have implemented two methods based 

on backward stepwise regression (e.g. McCuen, 2003) and on partial correlation coefficients 

to select the predictors. Backward stepwise regression starts with all the terms in the model 

and removes the least significant terms until all the remaining terms are statistically 

significant. The partial F-test which can be used for either adding a predictor to the equation 

containing q-1 variables or removing a predictor from the equation containing q variables is : 
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where n is the number of observations, Rq and Rq-1 are correlation coefficients between the 

criterion variable and a prediction equation having q and q-1 variables respectively. If F is 

greater than the critical F value, the predictor should be included in the equation. The critical 

F value is defined for a given level of significance and degrees of freedom 1 and n-q-1. A 

Bonferroni correction (Bonferroni, 1936) is used for the level of significance using the 

following formula: 

q
1

)
2

1(1 αα −−=     (8) 

where α  is the level of significance and q is the number of predictors in the equation. The 

partial F-test must be computed for every predictor at each step of stepwise regression. 
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Partial correlation is the correlation between two variables after removing the linear effect of 

the third or more other variables. The partial correlation between variable i and j while 

controlling for third variable k is (e.g. Afifi and Clark, 1996): 
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where Rij is the correlation coefficient between variables i and j. For the partial correlation 

approach, the p-value is used for eliminating any one of the predictors. The p-value is 

computed by transforming the correlation R to create a t-statistic having n-2 degrees of 

freedom, where n is the number of observations: 
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The probability of the t-statistic indicates whether the observed correlation occurred by 

chance if the true correlation is zero. 

In the SDSM model, a recursive algorithm is implemented to compute partial correlations 

using equation 9. This recursive algorithm has a limitation, i.e. when the partial correlation 

between two variables is computed, the number of other variables that can be removed is 

limited to 12. However, the number of NCEP predictors used for partial correlation analysis 

is usually more than 20 (as suggested in Table 1). In the ASD tool, to control this limitation 

and allow fast computation, the following algorithm is used for partial correlation analysis. 

The correlation between y and x1 controlling for x2, x3,…, xm is obtained by computing the 

correlation between the residuals of the following two linear models: 

 

),...,,( 321 mxxxfy =  (11) 

),...,,( 3221 mxxxfx =  (12) 
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Chapter 

2 
Getting started with the ASD 
 
The ASD tool is an easy to use graphical user interface for the statistical downscaling of 

GCM outputs to regional or local variables. ASD runs on all platforms that support 

MATLAB.  

Before You Start 

 
In order to run ASD you will need to provide daily observed local data (the predictand) and 

daily observed and GCM large-scale atmospheric data (the predictors). In Canada, daily 

observed local data can be obtained through Environment Canada – in particular daily data 

from the homogenised data set is available by contacting Lucie Vincent (temperature) and 

Eva Mekis (precipitation). Predictor data sets1, including both observed (i.e. from NCEP 

reanalysis) and GCM outputs (i.e. three series of predictors currently available are from the 

last three versions of the Canadian coupled GCM and one series from the coupled British 

GCM, HadCM3), can be downloaded from the Canadian Climate Change Scenarios Network 

(www.cccsn.ca). These data sets contain the large-scale climate variables which are likely to 

have the largest influence on local climate (see Table 1). The ASD naming convention and 

file formats follow that of SDSM and predictor and predictand files prepared for use in ASD 

can also be used in SDSM. If you are planning on using the ASD tool for a number of sites, it 

is probably wise to set up separate directories for each site. 

 

 

 
                                                                          

1 Note: The GCM predictor files provided by the CCCSN are for the period 1961-2100. If you wish to downscale for 
particular time periods, e.g., the 2050s (2040-2069) you will need to extract the relevant period from the complete data set 
before using the ASD tool. 

 8 
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Table 1: Predictor variables available from the CCCSN and their associated acronyms. *Note 
that according to the considered GCM, relative humidity variables are not available and are 

replaced by specific humidity. 

No. Predictor Code No. Predictor Code

1 Mean sea level pressure mslp 14 500hPa divergence p5zh 
2 1000hPa airflow strength p__f 15 850hPa airflow strength p8_f 
3 1000hPa zonal velocity p__u 16 850hPa zonal velocity p8_u 
4 1000hPa meridional velocity p__v 17 850hPa meridional velocity p8_v 
5 1000hPa vorticity p__z 18 850hPa vorticity p8_z 
6 1000hPa wind direction p_th 19 850hPa geopotential height p850 
7 1000hPa divergence p_zh 20 850hPa wind direction p8th 
8 500hPa airflow strength p5_f 21 850hPa divergence p8zh 
9 500hPa zonal velocity p5_u 22 Relative humidity* at 500hPa r500 
10 500hPa meridional velocity p5_v 23 Relative humidity* at 850hPa r850 
11 500hPa vorticity p5_z 24 1000hPa relative humidity* rhum 
12 500hPa geopotential height p500 25 Specific humidity at 2 m shum
13 500hPa wind direction p5th 26 Mean temperature at 2m temp 
 

All input data files should be a single stream of data with each row representing a single daily 

value (see Figure 2), generally covering regular calendar year (including leap years) over 3 or 4 

decades (e.g., 1961-1990 and/or 1961-2000). The predictor data sets are already in this format 

(and covering most of the time the 1961-1990 period), but you will probably need to reformat 

observed daily data files. 

 
Figure 2: Example of the format required for the input data sets. 
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There are two other files which ideally need preparing before starting the ASD tool – 

ncepdata.txt and gcmdata.txt, although they may be created and/or edited whilst within 

the ASD environment. These files contain a list of the predictor files available for the NCEP 

data (observed large-scale atmospheric variables) and for the GCM in question. Examples of 

these files are provided with ASD (look in the c:\Program Files\ASD directory) and can be 

edited if necessary. The order of the file names contained in these two files must be exactly 

the same and for ASD to work correctly the same predictor variables should be available for 

both the NCEP and GCM data sets. There is little point in calibrating a statistical model 

containing a predictor variable which is not available in the GCM data set since, if it is 

identified as a significant variable and used in the statistical model, it will not then be possible 

to downscale future climate scenarios. 

 
Starting ASD 

 
Start MATLAB. At the top of the MATLAB main window you will see a Current Directory 

window containing the directory path of the MATLAB work directory (e.g., 

c:\MATLAB7\work). Change this directory path so that it shows the location of the ASD 

programs (e.g., c:\Program Files\ASD). To start ASD, type “asd” at the MATLAB prompt. 

The ASD main window opens (Figure 3). 

 
Figure 3: The main menu of the ASD (Automated Statistical Downscaling) tool 

 10 



A S D  U S E R S ’  G U I D E  -  V E R S I O N  1 . 1 ,  N O V .  2 0 0 7  

Summary of steps to use the ASD tool 

 
The following list of steps outlines the main features of the ASD tool: 
 
1. Click on the Setting menu at the top of the ASD main window and select the NCEP 

predictors or GCM predictors option from the drop-down menu to open ncepdata.txt or 

gcmdata.txt file (Figure 4). Both these files contain a list of the available predictor file names 

– the order of the list and the content in each file must be identical. Edit or replace the files if 

necessary. 

 

Figure 4: Predictors menu of ASD tool 
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2. Click on the Setting menu at the top of the ASD main window and select the Parameters 

option from the drop-down menu. Enter the start date of current data, the start date of future 

data, the calibration start and end dates, the validation start and end dates and the year length 

for GCM data2 (Figure 5). Enter the Bias and VIF values manually or check the appropriate 

box to set them automatically (i.e. auto). These values are used only when generating scenarios 

using GCM predictor data. Enter the Percentile value that you would like to compute for the 

Comparing Statistics menu. Enter a threshold value for the identification of missing values 

(any values less than the threshold value will be treated as missing). Enter the number of 

scenarios you wish to generate (as for example in Figure 5, 100 synthetic data simulated series 

will be generated) and finally enter the projection periods (in Figure 5, 3 periods of 3 decades, 

centered over 2020s, 2050s and 2080s will be generated, respectively). 

 
Figure 5: The ASD Parameters menu 

                                                                          

2 Some GCMs do not have a standard year length and most do not include leap years. You will need to check the number of 
days in a year for the GCM you are using. GCMs from the Canadian Centre for Climate Modelling and Analysis (e.g., 
CGCM1, CGCM2, CGCM3) have a 365-day year, whilst those from the Hadley Centre for Climate Prediction and Research 
(e.g., HadCM2, HadCM3) have a 360-day year.  
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3. Return to the ASD Main Menu and click on the NCEP predictors, GCM predictors and 

predictand buttons to browse through the directory tree to find the directory paths to the 

predictor and predictand data files (Figure 6). In the “predictor number” selection, enter the 

number of the predictors which you wish to be considered in the calibration process (e.g., 1:26 

if the complete predictor data set is available, or, for example, 1:21 23 24, if only a subset of the 

complete suite is available). The predictor selection method gives three choices: stepwise, 

partial correlation or none (in this latter case, the process will be based on all predictors entered 

in the “predictor number”).  In the present model, two methods are implemented based on 

backward stepwise regression and partial correlation coefficients to select the predictors (see 

further information in Hessami et al., 2008). The significance level value corresponds to the 

value used in the Partial F-Test equation (see eq. (8) in Hessami et al., 2008). You can select the 

level value at your convenience, as the default value is fixed at the 0.05 level (see Figure 6). The 

maximum number of predictors can be also selected, according to the number of available 

predictors used to develop the multi-linear regression equation. ASD offers the choice of two 

methods: in addition to multiple linear regression, the option of using ridge regression is 

allowed, especially to alleviate the effect of the nonorthogonality (i.e. colinearity) of the 

predictor vectors. One example about the usefulness of using the ridge regression is given in 

Hessami et al. (2008). The model process can be conditional on the occurrence of an event (i.e. 

for precipitation) or unconditional (i.e. for temperature). In the case of a conditional process, a 

transformation function is first applied (i.e. by default the fourth root transformation is used) 

in order to improve the performance of the multiple linear regression since these predictand 

data (i.e. precipitation) tend not to be normally distributed. For temperature, this not the case 

and the predictand data are generally used as is.  Also, the model type can be based on monthly 

downscaling process or annual one (the two choices given in Model Type menu). As we are 

doing a statistical downscaling of precipitation in the example given in Figure 6, the model 

process is conditional and a threshold of 1mm/day (see the Threshold menu in Figure 6) is 

selected as the boundary between dry and wet days (< 1 mm/day and ≥ 1 mm/day, 

respectively). To calibrate the model and generate simulations using NCEP data, click on the 

Calibrate & validate model button. To generate scenarios using current and future GCM 

data, click on the Current climate model generation and Future scenarios generation 

buttons, respectively. (The actual values of the results of the calibration process and the data 

generated can be viewed in the Workspace window. If this window is not already displayed in 

the MATLAB main window, click on the Window menu and select Workspace or press 
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CNTL+3. Four variables will be displayed in this window: asdin (input variables), asdout 

(output variables), asdoutCGCM (output variables using the current period GCM data) and 

asdoutFGCM (output variables using the future period GCM data). If you double-click on any 

of the variables listed in the Workspace window, then the Array Editor opens with a list of the 

fields associated with each variable. Double-click on the desired field to display the values – 

these can be printed or you can select and copy them so that they can be pasted into another 

environment (e.g., Microsoft Excel.) 

 
Figure 6: Main menu of the ASD tool 

4. Click on the Graphs menu at the top of the ASD Main menu window and select Correlation 

coefficients from the drop-down menu. The correlations between the predictand and the 

NCEP predictors will be displayed (see Figure 7, 0 corresponds to the predictand and 1-26 to 

each predictor listed in Table 1). Click on the maximize window button in the top right-hand 

corner if the colour bar is not completely displayed. (All graphics can be customised by adding, 

for example, axis labels, titles etc. by clicking on the Insert menu on the graphics windows and 

 14 
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selecting the appropriate options. Graphics can also be copied and pasted into other 

applications using the appropriate commands on the Edit menu.) 

 
Figure 7: Correlation coefficients menu of ASD tool 

 

5. Click on the Graphs menu at the top of the ASD Main menu window and select Regression 

coefficients from the drop-down menu. The model regression coefficients for the NCEP 

predictors identified as explaining the most variance in the predictand (up to the maximum 

number of predictors specified in the ASD Main menu) will be displayed per month (i.e. 

Model type is Monthly in that case as shown in Figure 8). Again, click on the maximize 

window button in the top right-hand corner if the colour bar is not completely displayed.   

 15 



A S D  U S E R S ’  G U I D E  -  V E R S I O N  1 . 1 ,  N O V .  2 0 0 7  

 
Figure 8: Regression coefficients menu of ASD tool 

 

6. Click on the Graphs menu at the top of the ASD Main menu window and select Boxplot or 

Bar-plot from the drop-down menu. Then click on NCEP, GCM–Current and 

GCM-Future to compare the statistics for observations/NCEP data, observations/current 

GCM data and future GCM data respectively. Figure 9 shows the observed and simulated 

mean monthly values of precipitation obtained when using NCEP data, and the corresponding 

mean precipitation (mm/day) derived from observed data over the current period (1961-1990) 

and those downscaled over a future period (ex. 2011-2040) from the GCM predictors. Other 

statistical values which can be viewed are listed at the top of this window: standard deviation 

(STD), values for the selected percentile (i.e. that you have selected previously in the 

Parameters menu), percentage of wet days (Wet-day) and maximum number of consecutive 

dry days (CDD). For temperature variables, the mean, standard deviation, percentile, 

maximum and minimum absolute values can be viewed, printed or copied (as an image). All 

Box Plots are developed with the full ensemble runs, as the number was chosen in the 

Parameters menu (i.e. through the button “Number of scenarios”, ex. 100 in Figure 5) from 

NCEP or GCM predictors. At the bottom of all Box Plots graphs, the Root Mean Square 

Error (RMSE) is given and this corresponds to annual mean values averaged from all monthly 

RMSE (for both the calibration and the validation periods). 
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Figure 9: Comparing statistics menu of ASD tool 

7. Click on the Graphs menu at the top of the ASD Main menu window and select QQ-

plot3from the drop-down menu. Then click on Calibration-NCEP, Validation-NCEP, 

                                                                          

3 A quantile-quantile (q-q) plot can be used to determine if two datasets come from populations with a common distribution. 
In this type of plot, points are formed from the quantiles of the data and if the resulting points lie roughly on a line with a 
slope of 1, then the distributions are the same. 
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Calibration-GCM and Validation-GCM to see the Q-Q-plots between the observations and 

NCEP data and the Q-Q-plots between observations and GCM data for the calibration and 

validation periods (Figures 10 to 13, respectively). As for Box Plots, all Q-Q Plots are 

developed with the full ensemble runs, as the number was chosen in the Parameters menu (i.e. 

through the button “Number of scenarios”, ex. 100 in Figure 5) from NCEP or GCM 

predictors. At the bottom of all Q-Q Plots graphs, RMSE is given and corresponds to mean 

values averaged over all 100 runs and quantiles (for both the calibration and the validation 

periods). 

 

 

 

 
Figure 10: QQ-plot between observations and simulated values using NCEP data during  the 

calibration period. 
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Figure 11: QQ-plot between observations and simulated values using NCEP data during  the 

validation period. 

 

 

 
Figure 12: QQ-plot between observations and simulated values using GCM data during  the 

calibration period. 
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Figure 13: QQ-plot between observations and simulated values using GCM data during validation 

period. 
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Saving and retrieving parameters in ASD  

 
To save the input and output parameters as well as the simulated runs from current and 

scenario data generated by the ASD tool, click on the Save option in the File menu on the 

ASD Main menu, browse to the desired directory and then type an appropriate filename. The 

output file extension will be *.mat. Next time, when ASD starts, you can easily retrieve the 

selected model parameters by clicking on Open in the File menu and selecting the file, or by 

typing load *.mat in the Command Window.   

Examination of this *.mat file also provides the opportunity to view (and save or paste into 

other software packages) the values of the variables and data generated by ASD, including 

statistics and criteria of analysis as well as observed data for comparison over the current 

period. In order to view the values of the outputs, you need to have the MATLAB 

Workspace window displayed – if this is not already visible click on the Window menu and 

select Workspace from the drop-down menu, or press CNTL+3. Four variables will be 

displayed in this window: asdin (input variables), asdout (output variables), asdoutCGCM 

(output variables using the current period GCM data), and asdoutFGCM (output variables 

using the future period GCM data). (You can also see this list of variables by typing “who” at 

the command window prompt.) If you double-click on any of these variables listed in the 

Workspace window, then the Array Editor opens with a list of the fields associated with each 

variable. Double-click on the desired field to display the values – these can be printed or you 

can select and copy them so that they can be pasted into another environment (e.g., 

Microsoft Excel).  

In the event that MATLAB cannot display the values for a particular field (there is a 

maximum number of elements that MATLAB can display) you can still save this information 

into an ASCII file. For example, if you wish to save the future scenario output, type 

asdoutFGCM.Scen at the command window prompt. The data for the number of scenarios 

generated will be displayed. If you type “who” again, a new variable is displayed – ans. To 

save this as an ASCII file, type (for example): save scenarios.dat ans –ascii. This file will be 

saved in the current directory (e.g., c:\Program Files\ASD) unless you specify a different 

directory path. More information about importing and exporting files can be found in the 

MATLAB Help facility. 

 21 
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Quitting the ASD  

 
To quit the ASD tool, select Exit from the File menu, or click the close box. 
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